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1   INTRODUCTION

Thank you for installing Freeform or Freeform Plus version 2019.0.

We are pleased to announce the availability of the new version of Geomagic Freeform and Geomagic Freeform Plus. 

Geomagic® Freeform® and Freeform® Plus enable you to solve complex design and manufacturing challenges with the industry’s 
most comprehensive organic 3D engineering tools combining touch-based sculpting, surfacing, design intent modeling, 3D Scan 
processing, CAD interoperability and mold preparation. Experience the speed and precision afforded by working in an immersive design 
environment, where tools and objects can be manipulated with full freedom of motion as well as touch based interactions with objects in 
the scene. Get the sensation of clay modeling with the benefits of digital design.

This document outlines important information about this release. For information on what is new and improved in this version of 
Freeform and Freeform Plus, see New Features and Enhancements.

For more information about Freeform and Freeform Plus, please visit 3DS Support Knowledgebase - Geomagic Freeform and Freeform 
Plus.

Check out the Customer Support website.

Customer Support can be reached via e-mail at Geomagic.Support.Americas@3DSystems.com.

COPYRIGHT
©1993-2018. 3D Systems, Inc. All rights reserved. The content of this manual is furnished for informational use only, is subject to 
change without notice, and should not be construed as a commitment by 3D Systems, Inc. This document is copyrighted and contains 
proprietary information that is the property of 3D Systems, Inc. 3D Systems and the 3D Systems logo, Geomagic, and Freeform are 
registered trademarks, Touch is a trademark of 3D Systems, Inc. Use of the 3dsystems.com and Geomagic.com website constitutes 
acceptance of its Terms of Service and Privacy Policy. Any names, places, and/or events in this publication are not intended to 
correspond or relate in any way to individuals, groups or associations. Any similarity or likeness of the names, places, and/or events 
in this publication to those of any individual, living or dead, place, event, or that of any group or association is purely coincidental and 
unintentional.

http://softwaresupport.3dsystems.com/knowledgebase/category/?id=CAT-01497
http://softwaresupport.3dsystems.com/knowledgebase/category/?id=CAT-01497
http://softwaresupport.3dsystems.com
mailto:Geomagic.Support.Americas%403DSystems.com?subject=Geomagic.Support.Americas%403DSystems.com
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2   INSTALLATION

SYSTEM REQUIREMENTS
For the Freeform Family of products, the system requirements, can be found on the support website: Freeform Family System 
Requirements. Note that some users have had success running system configurations that deviate from the supported list. In such 
cases, these configurations are not officially supported by 3D Systems, Inc.

Additionally, we test a variety of hardware platforms in combination with the graphics subsystems. While we make every attempt to 
be as thorough as possible, hardware manufacturers change their products frequently and may be shipping newer products or have 
discontinued active support for others. Check the support section of the Web site for the latest system requirement information and 
specific qualified systems.

Supported Graphics Cards
For the Freeform Family of products, the system requirements, including a list of qualified graphics cards, can be found on the support 
website: Freeform Family System Requirements.

DOWNLOAD AND INSTALL SOFTWARE
You can download and install the software from Getting Started, select the Freeform or Freeform Plus product, select to download 
Freeform or Freeform Plus.

In addition, automatic software updates are available if you selected Check for updated versions of the software in the 
Tools>Options>General>Updates dialog, a valid maintenance code is activated, and your computer is connected to the Internet. The 
application will check if a newer version is available and will download it automatically for installation.

If you have a Touch device attached and the Touch Device Driver (TDD) is installed, this option will also prompt you if there is an 
updated TDD available to download. Deselect this option if you do not want to be informed that updated versions of the software are 
available.

ACTIVATE LICENSE
Geomagic Freeform or Freeform Plus product requires license activation to run the application on your PC. You can choose to use an 
evaluation license for a 15-day period or activate a permanent license by using a virtual or physical dongle. 

After you start your application, the License Utility window opens. The License Utility allows you to activate and use the Freeform or 
Freeform Plus software.

NOTE: When you launch the License Utility, you can click the Help button to read the Licensing Guide . 

You should have received an email from 3D Systems with your activation code. If you have not received an email from 3D systems, 
contact them at Geomagic.Support.Americas@3DSystems.com.

If you are an existing user and have already activated the license on your PC with the previous version of the application, you can run 
the newer version of the application without re-activating the license. 

For more information, go to Getting Started, select the Freeform or Freeform Plus product, then click Licensing.

LICENSING AGREEMENT
Please see the End User License Agreement (EULA) located in the <Installation Directory>\Documentation\License.rtf folder for 
complete terms and conditions of the license. 

TOUCH DEVICE DRIVERS (TDD)
This software is optimized to run with the latest version of the Touch Device Driver. As this version of Freeform is released, the current 
Touch Device Driver is v2018.7.31, which includes the new Touch Smart Setup Application*, as well as support for the new TouchX USB 
device. To download and install the latest TDD go to Getting Started, select the Freeform product, select to download Freeform and 
then select the most up-to-date device driver that is compatible with your device.

*NOTE: The new Touch User Guide on the product downloads page contains additional information on installing the 
driver TDD 2018 .7 .31, as well as usage information on the new Touch Smart Setup application . The advanced Setup 
and Diagnostic applications are still available by way of the Touch Device Driver’s application directory should the 
optional desktop shortcuts not have been chosen during the TDD installation process .
NOTE: As we release v2019 .0, the legacy Firewire Omni Devices are no longer supported within the Freeform family 
of products . Please contact your local sales representative for information regarding newer devices and upgrade 
options, or visit our website: 3D Systems Haptic Device Product Lineup .

https://3dssupport.microsoftcrmportals.com/knowledgebase/article/KA-01404/en-us
https://3dssupport.microsoftcrmportals.com/knowledgebase/article/KA-01404/en-us
https://3dssupport.microsoftcrmportals.com/knowledgebase/article/KA-01404/en-us
http://3dssupport.microsoftcrmportals.com/getting-started
mailto:Geomagic.Support.Americas%403DSystems.com?subject=Geomagic.Support.Americas%403DSystems.com
http://3dssupport.microsoftcrmportals.com/getting-started
http://3dssupport.microsoftcrmportals.com/getting-started
https://www.3dsystems.com/scanners-haptics
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REQUIRED HARDWARE
Freeform v2019.0 requires a minimum display resolution of 1920 x 1080. Also, using custom desktop display settings that apply font 
and icon scaling may cause menu and dynabar contents to not fit properly.

Freeform v2019.0 also minimally requires a graphics card with OpenGL 3.0 support, and OpenGL 4.3 enables the software to provide 
additional performance enhancements.

NOTE: You may receive a warning when you launch the product should either your card or driver not support OpenGL 3 .0 as 
required . If you receive the following warning, go to the manufacturer’s website and download the most recent driver .

NOTE: Some older graphics cards may not have OpenGL 3 .0 compatible drivers available . See your manufacturer’s 
options . 

When using cards and drivers that support OpenGL 4.3 you will be able to take advantage of the newer high resolution transparency 
options and improved framerates added in v2017.0. While the product may still run without this graphics capability, you will not 
experience the new capabilities .

For the Freeform Family of products, the system requirements, including a list of qualified graphics cards, can be found on the support 
website: Freeform Family System Requirements.

OPERATING SYSTEM
A 64-bit version of Windows 7, 8, or 10 is required to run this version of the software. 32-bit is not supported.

NOTE: The pending fall release of v2019 .0 will be the last major version of the Freeform Family that will support Windows 7 .

BACKWARDS COMPATIBILITY
Old Files - This version will open models that were created in older versions of Freeform or Freeform Plus, however, models created in 
this version may not be compatible with previous versions (see notation under “Sketch Text” and “Solid Pieces” below). 

When a file is opened in Freeform, it is automatically converted to the current format. Once converted and saved, the model may lose 
compatibility with older versions. We strongly recommend that you save backup copies of all Freeform files from previous versions 
before opening them in a newer version.

INSTALLING MULTIPLE COPIES OF FREEFORM SOFTWARE
The Freeform v2019.0 installer allows for up to two side-by-side installations of the same major version or point release. For example, 
you can have one version of v2017.1 and the other version of v2019.0. However, only one version can be run at a time.

https://3dssupport.microsoftcrmportals.com/knowledgebase/article/KA-01404/en-us
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3   NEW FEATURES AND ENHANCEMENTS

The following is a summary of new features and enhancements in FreeForm v2019.0. For a more comprehensive look at the new 
features and enhancements in the v2019.0 release see the online Help topic titled “What’s New?” You can access the help from within 
the FreeForm application by pressing F1 or from the Help Menu. 

NOTE: Customer-requested issues are noted with an * .

NOTE: The ‡ symbol indicates features that are only available in Freeform Plus .

WHAT’S NEW IN 2019 .0

Dynabot Automation ‡ *
The new Dynabot automation tool enables users to define bundled sets of specific sequenced processes that can be saved and 
organized as macros, to be re-run in an automated manner.

Some information on Dynabot:

Dynabots allow users to automate repeatable process or tasks in their daily workflow, saving time, adding consistency, and supporting 
new teammates. Whether being used to create simple single-click functions out of bundled sets of tasks or to automate or guide entire 
workflows, Dynabots can be as simple or as complex as you desire. Dynabot Tasks are commands that trigger functionality in the 
application by simulating user inputs (such as device clicks and keyboard text entry). Tasks may be recorded based upon user inputs, 
then edited from within the Dynabot Editor Dialog, which is accessible through the Tools menu (or via the Keyboard Shortcut “U”).

After recording, task lists may be configured to perform increasingly intricate workflows.

                              

For more information on the Dynabot tool, refer to the following Help topic: Dynabot, or refer to the Dynabot Manual found in the 
Documentation folder in the App Install Directory: 

C:\Program Files\3D Systems\Freeform Plus 2019 .0 .xx\Documentation\Tutorials and Manuals\Freeform Dynabot  User Manual .pdf
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Suite of New Consolidated Hybrid Construction Tools ‡ *
A new Hybrid Tools palette containing a suite of new hybrid construction tools has been added for this release, as shown below:

      

The newly added Hybrid Tool Suite replaces the legacy construction tools (Wirecut, Revolve, Curve Network to Piece, Loft, and 
Sweep) each serving as a single point of entry for construction of any object type (clay, mesh, solid, SubD). The new Hybrid Extrude 
and Revolve tools include an updated UI and infrastructure that matches that of standard CAD applications, including support for 
bidirectional extrusion, independent controls for drafting, and different choices for termination modes. Also available in v2019 is a 
preview of the extrusions that reflect the visual color cues relevant to the chosen geometry output specified for the function. Three 
optional Apply modes for SubD outputs are included, reflecting various continuity choices for the output SubD body.

NOTE: The legacy versions of these tools are still available, and may be made visible by way of the Tools - Options - Interface - 
Palettes menu.

See the Hybrid Tools Palette for more information.
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Interactive Guided Workflow Palette
A new workflow wizard infrastructure has been implemented for this release to enable the in-app display of interactive guided 
workflows. 

About Guided Workflows (Workflow Wizards):
Guided workflows are interactive HTML based wizards that are used to train or guide users by providing step-by-step instructions, 
images, and resource links.  A “Getting Started” training guide is provided with this release. It can be found on the Training Guides 
palette, which is located at the top of the palette stack on the left side of the workspace.

                 

When a guided workflow is opened, it will be docked at the left side of the screen by default, with options for other display modes 
available in Tools - Options menu.



73D Systems, Inc.

There are two types of training guide support provided in v2019 and two respective palettes: 
• Training Guides: Training guides are interactive guided workflow intended to training users on using the application. 

• My Solutions ‡: In comparison to Training Guides, My Solutions are optional guided workflows that are industry or workflow 
specific, and which provide step-by-step instructions for a specific workflow process. Unlike Training Guides, My Solutions 
workflows can accommodate buttons which invoke embedded Dynabots as a means enhance productivity.

Guides may be organized from within the Customize dialog, with options to also import new guides from an external location 
NOTE: The palettes are disabled/enabled from the Tools Menu - Options - Interface - Workflows window.

See Tools Menu - Customize for more information.
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UI Enhancements

Palette Customization and UI Enhancement *
Users now have the ability to simplify their workspace by filtering palettes or palette tools from display in the UI.

Options to specify which palettes and tools should display can be specified from

Tools>Customize>Palette Filter:
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Color Theme and Transparency Options

Freeform 2019.0 provides the ability to customize the application appearance by choosing amongst 7 new optional UI Themes and 
optional dialog Transparency settings. The UI Theme options, available from the Tools - Options - Interface – UI Theme menu, allow the 
user to select from a variety of preset themes.

The Transparency options, accessible from the Tools - Options - Interface - Transparency menu, allow the user to adjust the opacity 
of the Object List, Toolbox Windows and Options Dialog, providing a less obstructed experience with a greater amount of visible 3D 
Workspace.

See Tools - Options - Dialog for more information.

Spacebar Favorites List Enhancements
The Spacebar Favorites List is a Quickstart Menu that conveniently displays at the tip of the user’s cursor when the spacebar is clicked. 

This customizable menu provides easy access to frequently used functions.

Enhancements to the Spacebar Menu for v2019 include the addition of tool icons for better readability, along with more tools for menu 
organization that provide the ability add custom column separators.  

See Tools - Customize - Favorites List for more information.



103D Systems, Inc.

Mouse-Wheel Scroll for Palette Stack *
Freeform 2019.0 has integrated mouse scroll wheel control with the Palette Stack, enabling an additional way to easily traverse the 
palettes. 

Tool Enhancements

Pattern Piece UI Enhancement *
The Pattern Piece Tool has been completely redesigned, optimized and enhanced for v2019, significantly enhancing its utility and ease 
of use.

A new Pattern Piece Options dialog allows users to make choices about the patterned object’s orientation and handling:

Additionally, an updated dynabar allows for more discoverable way to define the target:

Additional Pattern Piece Enhancements *
• Patterning along sets of curves

• Patterning of empty pieces

• Patterning sets of pieces

• Include dependent objects in patterns

• Spacing options on scale

See Construct Clay Palette - Pattern Piece for more information.
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Axis Marker *
The Axis Marker tool has been enhanced in this release to provide improved functionality, ease of use, and more flexible control of 
attributes.

The new features help users to control clearance distances between markers. A concentric ring displays in the scene to reflect the 
clearance distance for each marker, and haptic bump stops assure that assigned clearance distances between each marker are 
enforced during interactive manipulations in the scene. 

In addition, the unique parameters for each marker now persist with the file, can be shown simultaneously in the scene, and are fully 
editable at a later date. A new Flip option allows the extension direction for the marker to reverse its direction to be internal to the part if 
desired.

See Curves Palette - Axis Marker for more information.

Autosurfacer: Support to Define Curve-bound Regions and Boundary Continuity ‡ *
Freeform Plus v2019.0 allows for the ability to define curve-bound regions for the Autosurfacer to respect during surfacing.  Passing 
curve-bound regions to the Autosurfacer has two primary benefits: 1) it gives users the ability to define regions, and 2) it allows the user 
to control the continuity of the patch surfaces across each boundary curve. This allows for the creation of meaningful patch boundaries 
and feature aligned edges necessary for downstream manufacturing.

By assigning an Autosurfacer related continuity attribute to a curve through the Object list, that curve will be identified as one to be used 
should the “Use Contour Curves” option be turned on in the Autosurfacer dialog.

   

See Object List - Context Menu - Autosurface for more information.
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Color Management *

New Boolean Color Management Options *
The new Paint Blending menu in the piece combine dialogs has multiple modes to control how paint gets combined, allowing the user 
to mitigate the issues of blocky intersections and thin paint layers.

See Object List - Context Menu - Combine Into for more information.

Paint Tool Enhancements *

The Paint Tool now offers the ability to combine the piece color and paint color by selecting the Convert Piece Color to Paint option.

The Paint Tool now has two new functions for efficiently managing color:

1. Convert Piece Color to Paint:  enables piece color to be converted to and merged with  existing Paint color 

2. Multi-Piece Checkbox: enables color changes to apply to both the Active Piece and any additionally selected clay (voxel) pieces

See Paint Clay Palette - Paint Tool for more information.

Artec Scanning *
Freeform 2019.0 allows the user to select a preview display preference for the Artec Scanning tool from either a floating window, or a 
full-screen view. 

The user may now also select from multiple histogram rendering options.

See Tools Menu - Options - General - Artec Scanning for more information.
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4   BUG FIXES

NOTE: Customer-reported issues that have been resolved are noted with an * .

NOTE: The ‡ symbol indicates features that are only specific in Freeform Plus.

Bug Fixes in 2019 .0
This section lists issues that have been resolved in the 2019.0 release:

• GF-3365: Autosurfacer: Has issues when there are discontiguous volumes in one piece.

• GF-6611: Autosurfacer: Shelled Pieces or Interior voids - Results skip exterior and surface some interior shells

• GF-7733: Boolean: The new dialog Output section label does not match units set in preferences ‡ *

• GF-6421: Convert (Solid) to Clay: Convert with Profile - Fill option does not work with multiple solids visible in scene, regressed 
15.0.41 ‡

• GF-6474: Convert to Clay: Convert Solid or Patch - Thicken and Fill mode does not reset properly for patch selection ‡

• GF-7705: Copy from Edge - Creates curve networks that have inconsistencies between curve and curve endpoints ‡

• GF-6304: Create Patch: App hangs using Fit to Clay & Create All Connected Patches for this file ‡

• GF-6662: Dynabar: Strings - Some strings are clipped in dynabar 

• GF-7788: Dynabot: Cannot export unicode characters to HTML or save to XML ‡ *

• GF-6239: Edit & Stitch Mesh: Error on applying make clay for a simple file, .ini problem ‡

• GF-6331: Edit & Stitch Solid: Crash on Stitch using this file ‡

• GF-6679: Edit SubD:  Dynabar’s Add Loop Mode and Extrude Edge Mode - After clearing the Compression Pop-up on 
File>Save, Dynabar not cleanly resetting 

• GF-6668: Edit SubD: Crash deleting two faces on Cube SubD

• GF-7219: Emboss with Image:  File>New after exiting the tool does not reset  EWI pref persistence, causing later Emboss 
plane to initialize in the wrong place  

• GF-7675: Emboss with Wrapped Image - Selection of curves from OL is not recognized by the tool (affects Dynabot)

• GF-6448: Export: 3MF - Adding a pattern to displacement layer prevents export to 3MF

• GF-6508: Export: IGES - Curves can potentially become misshapen  in the IGES output file based on the active piece 
coarseness during export

• GF-6587: Extrude to Plane: Label for degrees in dynabar is incorrect

• GF-4443: FF Uninstall: msi related permissions warning thrown regarding “Unknown Publisher”

• GF-6248: File Open: SubD Paint color displayed in black when Auto See-Through enabled, regressed from 16.2

• GF-7143: Font: Mass Properties - Clipped strings after global font change to Segoe UI

• GF-6647: Freeform Install: Error installing .NET Framework 3.5 SP1 (Needed for Capture Scanner)

• GF-2837: TDD - Phase 2 UI/UX Improvements -  Rework the Setup and Diagnostic Utility Dialog Windows

• GF-6598: Help Doc:  FFP Only Symbol -  Clay Piece Context Menu - 2 Batch Reduce  Settings have red symbols ‡

• GF-7924: Help Menu: Crashes being seen on drag and resize *

• GF-7789: Import to Plane: Image Import - Inadvertently directed to MSR tool, but should go to the  Select Sketch Object tool  
for setting import parameters

• GF-6507: Import/Export: Unable to export 2 out of 6 curves to iges in this example *

• GF-4306: Import: Error reading file when importing a legacy Solidworks file (SW 2004) ‡

• GF-6286: Intersection Curves Lost when Editing a Shape Patch Feature ‡

• GF-6755: Loft Clay & Solid: Problems on applying guide step and leads to crash on undo/redo, regression from 16.2

• GF-6761: Loft Clay: Solid Piece - Apply Loft Clay to solid piece silently fails ‡

• GF-6307: Loft Solid: Solid Piece - Cut Inside does not work every time using this file ‡

• GF-7173: Loft: Exiting the tool without applying feature, edits the sketch if shape is modified

• GF-7345: Mesh Utilities: Divide - OBJ files that contain materials or objects crash application when doing a mesh divide
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• GF-5290: OL: Boolean - Final result when using boolean ops and result type set to Mesh does not hide Source and Target as 
per our standard protocols.

• GF-7596: OL: Reduce Mesh - Curvature Quality string clipped 

• GF-5427: Paint SubD: Paint color not applied (face painted in black) when See through enabled

• GF-6509: Patch Display Menu - Solid Pieces: Fit-color does not work for solids created with Fit to Boundaries patches ‡

• GF-6766: Performance: Windows 10 1709 - Slow performance and startup with Windows 10 1709 Fall Creators Update

• GF-6623: Project Patch to Clay: Deselect profile loop does not reset dbar back to original state ‡

• GF-6641: Reposition: Selection Center triad did not move to the center after cancel on Transform 

• GF-6295: Reposition: Shape Patch - Cannot Edit a Solid Shape Patch Feature after Repositioning a Common Solid ‡

• GF-6429: Reposition: Shape Patch - Crash if the curve is dissociated and undone ‡

• GF-6356: Reposition: The Registration button disappears by launching the tool with hotkey

• GF-7801: Save View Images: Save Standard (Orthographic) - Out of memory error when using Crop Image to Piece(s) option

• GF-7672: Select Sketch Object:  Ellipse - Modifying the XY values for an ellipse center doesn’t adjust for plane “graph paper” 
center 

• GF-6450: Send to 3DSPRINT: Cannot send any piece to 3DSPRINT while actively in separate tool

• GF-7288: Shape Patch: Dragging a patch by selecting a curve endpoint results in file corruption/crash if while releasing, the 
section curve is visible in grey ‡

• GF-7774: Shape Patch: ‘Edit Points’ string clipped ‡

• GF-7831: Sketch: Control Point Curve - X & Y fields displays value = 1.#IO, regressed from 16.2

• GF-7541: Sketch: Move, Rotate, Scale  - Negative entries reset to -0.000, failing to implement a negative move on “Go” (recent 
regression)

• GF-7827: Sketch: Select Sketch - Numeric field for Edit Points is not updating correctly when switching selection between 
freehand and control point curves *

• GF-6167: Solidify: Curves no longer paired to solid after applying solidify (adding a user cue to the status bar message) ‡

• GF-7646: Spin Clay & Solid - Crash exiting spin tool after selecting profiled

• GF-6678: SubD: Add Loop - Crash when adding loop on symmetrical piece by dragging preview loop to symmetry plane

• GF-6557: Sweep Clay: Fit Patch/Solid Surface - Cannot select a curve fit to a Solid Piece 

• GF-6340: Sweep Soild/Clay: Fit Patch/Solid Surface - Sweep did not create along selected profile

• GF-6342: Sweep Solid/Clay: Case where plane did not reposition to selected curve

• GF-7623: Tools > Options: the number of incremental saved versions is not displayed correctly (Regression) *

• GF-6212: Translations: File Compression Dialog - One string is not translated

• GF-6205: Translations: Save View Images - Strings are not localized for the view name

• GF-6418: View Manipulation Widget: Rendering Anomaly surrounds the mouse driven cursor as it passes over the widget’s 
background

• GF-5613: Wire Cut Solid: Crash on raise for this particular file ‡

• GF-6306: Wire Cut Solid: Cut Outside failed overlapping profiles ‡

• GF-6058: Wire Cut Solid: Solid Pieces - Empty solid piece created in OL and Crash on undo/redo ‡

• GF-6059: Wire Cut Solid: Solid Pieces - Random results on create inside ‡

• GF-7598: Wire Cut: Select All Profiles Mode - OL Selections -  Results in only one profile being selected while automatically 
advancing to the next step (affects all iterations of Wire Cut, Shell Cut, and Raise/Lower)

• GF-7445: Wirecut Mesh and Solid - Error “Badly formatted profile” when trying to use Wire Cut *

5   KNOWN ISSUES
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Known Issues in 2019 .0
This section lists issues that have been identified in the 2019.0 release:

USB Enabled Touch Devices:

When using USB enabled Touch Devices, it is important to turn off the Window’s Permission to put the port into Power Save mode. In 
Device Manager, under the USB Host Controller, un-check the Power Management Tab’s option to “Allow the computer to turn off this 
device to save power.” 

Japanese Font Issue:

There are cases where dynabar labels use characters that are too compressed and illegible, and not using standardized Meiryo font 
designed for better readability.

Scheme Colors:

The Customcolor.txt file is not properly written out in the Japanese or Chinese User Interface.

Keyshot:

KeyShot live linking does not work with the latest Keyshot v7.3.40.

Sending Files from Freeform Family Products to 3D Sprint v2 .9: 

To address an initialization issue for file passing to 3D Sprint v2.9, launch 3D Sprint once and set any printer as a current one, and 
close the application.

New Quick Reference Guide

An updated Quick Reference Guide is being created for v2019. Please look for it on the Freeform download page on the 3DS

website: Getting Started

http://3dssupport.microsoftcrmportals.com/getting-started
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